Legal Notices

Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product may only be used in accordance with the license agreement.

This document is protected under copyright law. An authorized licensee of may reproduce this publication for the licensee’s own use in learning how to use the software. This document may not be reproduced or distributed, in whole or in part, for commercial purposes, such as selling copies of this document or providing support or educational services to others. This document is supplied as a guide for. Reasonable care has been taken in preparing the information it contains. However, this document may contain omissions, technical inaccuracies, or typographical errors. Avid Technology, Inc. does not accept responsibility of any kind for customers’ losses due to the use of this document. Product specifications are subject to change without notice.

Copyright © 2010 Avid Technology, Inc. and its licensors. All rights reserved.

The following disclaimer is required by Apple Computer, Inc.: 
APPLE COMPUTER, INC. MAKES NO WARRANTIES WHATSOEVER, EITHER EXPRESS OR IMPLIED, REGARDING THIS PRODUCT, INCLUDING WARRANTIES WITH RESPECT TO ITS MERCHANTABILITY OR ITS FITNESS FOR ANY PARTICULAR PURPOSE. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION MAY NOT APPLY TO YOU. THIS WARRANTY PROVIDES YOU WITH SPECIFIC LEGAL RIGHTS. THERE MAY BE OTHER RIGHTS THAT YOU MAY HAVE WHICH VARY FROM STATE TO STATE.

The following disclaimer is required by Sam Leffler and Silicon Graphics, Inc. for the use of their TIFF library:
Copyright © 1988–1997 Sam Leffler
Permission to use, copy, modify, distribute, and sell this software [i.e., the TIFF library] and its documentation for any purpose is hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The following disclaimer is required by the Independent JPEG Group:
This software is based in part on the work of the Independent JPEG Group.
This Software may contain components licensed under the following conditions:
Copyright (c) 1989 The Regents of the University of California. All rights reserved.
Redistribution and use in source and binary forms are permitted provided that the above copyright notice and this paragraph are duplicated in all such forms and that any documentation, advertising materials, and other materials related to such distribution and use acknowledge that the software was developed by the University of California, Berkeley. The name of the University may not be used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED "AS IS" AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

Copyright (C) 1989, 1991 by Jef Poskanzer.

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. This software is provided "as is" without express or implied warranty.

Copyright 1995, Trinity College Computing Center. Written by David Chappell.
Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. This software is provided "as is" without express or implied warranty.

Copyright 1996 Daniel Dardailler.

Permission to use, copy, modify, distribute, and sell this software for any purpose is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation, and that the name of Daniel Dardailler not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. Daniel Dardailler makes no representations about the suitability of this software for any purpose. It is provided "as is" without express or implied warranty.

Modifications Copyright 1999 Matt Koss, under the same license as above.

Copyright (c) 1991 by AT&T.

Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire notice is included in all copies of any software which is or includes a copy or modification of this software and in all copies of the supporting documentation for such software.

THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, NEITHER THE AUTHOR NOR AT&T MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

This product includes software developed by the University of California, Berkeley and its contributors.

The following disclaimer is required by Nexidia Inc.:
© 2006 Nexidia. All rights reserved.

Manufactured under license from the Georgia Tech Research Corporation, U.S.A. Patent Pending.

The following disclaimer is required by Paradigm Matrix:
Portions of this software licensed from Paradigm Matrix.

The following disclaimer is required by Ray Sauers Associates, Inc.:
"Install-It" is licensed from Ray Sauers Associates, Inc. End-User is prohibited from taking any action to derive a source code equivalent of "Install-It," including by reverse assembly or reverse compilation. Ray Sauers Associates, Inc. shall in no event be liable for any damages resulting from reseller's failure to perform reseller's obligation; or any damages arising from use or operation of reseller's products or the software; or any other damages, including but not limited to, incidental, direct, indirect, special or consequential Damages including lost profits, or damages resulting from loss of use or inability to use reseller's products or the software for any reason including copyright or patent infringement, or lost data, even if Ray Sauers Associates has been advised, knew or should have known of the possibility of such damages.

The following disclaimer is required by Videomedia, Inc.:
"Videomedia, Inc. makes no warranties whatsoever, either express or implied, regarding this product, including warranties with respect to its merchantability or its fitness for any particular purpose."

"This software contains V-LAN ver. 3.0 Command Protocols which communicate with V-LAN ver. 3.0 products developed by Videomedia, Inc. and V-LAN ver. 3.0 compatible products developed by third parties under license from Videomedia, Inc. Use of this software will allow "frame accurate" editing control of applicable videotape recorder decks, videodisc recorders/players and the like."

The following disclaimer is required by Altura Software, Inc. for the use of its Mac2Win software and Sample Source Code:

The following disclaimer is required by Ultimatte Corporation:
Certain real-time compositing capabilities are provided under a license of such technology from Ultimatte Corporation and are subject to copyright protection.

The following disclaimer is required by 3Prong.com Inc.:
Certain waveform and vector monitoring capabilities are provided under a license from 3Prong.com Inc.
The following disclaimer is required by Interplay Entertainment Corp.:

The “Interplay” name is used with the permission of Interplay Entertainment Corp., which bears no responsibility for Avid products.

This product includes portions of the Alloy Look & Feel software from Incors GmbH.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

© DevelopMentor

This product may include the JCifs library, for which the following notice applies:

JCifs © Copyright 2004, The JCIFS Project, is licensed under LGPL (http://jcifs.samba.org/). See the LGPL.txt file in the Third Party Software directory on the installation CD.

Avid Interplay contains components licensed from LavanTech. These components may only be used as part of and in connection with Avid Interplay.

Attn. Government User(s). Restricted Rights Legend

U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or “commercial computer documentation.” In the event that such Software or documentation is acquired by or on behalf of a unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms of the License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks

Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries. Apple and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other countries. Windows is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other countries. All other trademarks contained herein are the property of their respective owners.

Footage

Arri — Courtesy of Arri/Fauer — John Fauer, Inc.
Bell South “Anticipation” — Courtesy of Two Headed Monster — Tucker/Wayne Atlanta/GMS.
Canyonlands — Courtesy of the National Park Service/Department of the Interior.
Eco Challenge British Columbia — Courtesy of Eco Challenge Lifestyles, Inc., All Rights Reserved.
Eco Challenge Morocco — Courtesy of Discovery Communications, Inc.
It’s Shuttletime — Courtesy of BCP & Canadian Airlines.
Nestlé Coffee Crisp — Courtesy of MacLaren McCann Canada.
Saturn “Calvin Egg” — Courtesy of Cossette Communications.
“The Big Swell” — Courtesy of Swell Pictures, Inc.
Windhorse — Courtesy of Paul Wagner Productions.

Arizona Images — KNTV Production — Courtesy of Granite Broadcasting, Inc., Editor/Producer Bryan Foote.
Canyonlands — Courtesy of the National Park Service/Department of the Interior.
Ice Island — Courtesy of Kurtis Productions, Ltd.
Tornados + Belle Isle footage — Courtesy of KWTV News 9.
WCAU Fire Story — Courtesy of NBC-10, Philadelphia, PA.
Women in Sports – Paragliding — Courtesy of Legendary Entertainment, Inc.

Avid MetaFuze User’s Guide v2.3 • December 2010
Contents

Chapter 1  Using Avid MetaFuze ................................................................. 9
  Film and High-Resolution Workflows using MetaFuze .............................. 9
  Opening a Project in MetaFuze .......................................................... 11
  Customizing the MetaFuze Window ..................................................... 12
  Scanning your Folders ........................................................................ 13
  Transcoding your Files ........................................................................ 15
  Configuring the MetaFuze Transcoder .................................................. 23
  Using LUTs in MetaFuze ...................................................................... 23
  Transcoding your Files in a Batch ......................................................... 27
  Exporting an ALE from MetaFuze ........................................................ 28
  Importing MXF Files into Avid Media Composer .................................... 29
  Linking to MXF or GEN Files in Avid DS ............................................. 31

Chapter 2  Avid MetaFuze Reference ......................................................... 33
  Scan Folders Dialog Box ................................................................... 33
  Group View ....................................................................................... 35
  Detail View ....................................................................................... 38
  Details of a group.............................................................................. 39
  Details of a file.................................................................................. 40
  Details of a transcode job................................................................. 40
  Details of a stereoscopic group or transcode job.................................. 42
  Details of R3D groups or transcode jobs............................................. 42
  Output Preset View .......................................................................... 43
  Create XML Batch Dialog Box .......................................................... 45
  Burn-in Editor Dialog Box ................................................................. 45
  Transcode Configuration Options ....................................................... 46
Avid MetaFuze provides a complete offline-to-finish file-based workflow when used in conjunction with Avid Media Composer and Avid DS. Metafuze allows the generation of MXF media from third-party files (such as DPX, R3D, TIF and QuickTime), which can be offlined in Avid Media Composer, and conformed for finishing in Avid DS.

**Film and High-Resolution Workflows using MetaFuze**

Single-frame files generated from digital video cameras, film scanning processes or CGI applications, need to be converted to playable media so that they can be read by an Avid editing application like Avid DS or Avid Media Composer. Avid MetaFuze transcodes consecutive single-frame files (with metadata contained as part of the format) and raw data files from a digital camera into an MXF or an Avid DS .GEN file.

Avid MetaFuze supports different files including R3D, ARRI, DPX, TIF, and JPG. It can also transcode QuickTime and AVI sequences.

*Any file type supported by Avid DS or third-party parsers can be read by Avid MetaFuze. Still-file parsers can be written for both MetaFuze and Avid DS using the parser SDK which is available as part of the Avid DS SDK.*

The illustration below shows a typical example of a file-based workflow for editing film footage on an Avid Media Composer or Avid DS.
Using Avid MetaFuze

This workflow shows you how to carry out editing and finishing on footage that is already in digital file format.

**Step 1: Group high-res files into MXF or GEN files**

High-resolution digital files could originate from digital cameras, film-scanning facilities, or CGI applications. The files include formats such as R3D, DPX, or TIF.

If you need to work with high-res file formats that cannot be read by Media Composer, start by using Avid MetaFuze to transcode these files to an HD resolution. MetaFuze transcodes the single-frame files into an MXF file that can be read by Avid Media Composer®. (Any metadata originally contained in the file will also be included; or for non-metadata formats like TIF, metadata can be added.)

Media Composer can link to and output RED footage in HD RGB 4:2:2 or 4:4:4. However, if you need to output at a higher resolution than HD, you should transcode the RED files using MetaFuze and do the offline edit using MXF files. When you conform your Media Composer sequence in Avid DS, you will be able to link to the original RED footage to do the finishing and output.

If you intend to edit directly in Avid DS, then you may transcode your files to GEN format.

**Step 2: Edit sequence by linking to HD or high-res media**

On an Avid Media Composer, link directly to the MXF media to edit your sequence. From here, you can output directly to HD or SD. However, should you need to output back to high-res media (2K or higher), export the sequence as an AFE for finishing on Avid DS.
Step 3: Conform AFE for finishing in Avid DS

On Avid DS, you can conform the AFE and connect to the original DPX/R3D/TIF files.

In the case of DPX files, necessary information such as KeyKode™ (key number) and timecode is inserted as metadata into the DPX file during the scanning process. If the DPX files do not contain the timecode information, the ALE is required in order to make the necessary correspondence to the associated DPX files. The ALE is usually supplied by the film-scanning facility or output by MetaFuze/Avid Media Composer.

The transcoded MXF file used in Media Composer is not required for the finishing process but it could be imported onto a separate video track in Avid DS and used as part of the conform check process.

Depending on your system configuration, many high-resolution formats are playable in real time — for a specific list of these formats, see the Avid DS support web at www.avid.com. When editing high-resolution projects where real-time playback is not achievable, you can use the proxy mode to apply effects and view the results in HD 4:2:2 or HD 4:4:4.

Step 4: Output to tape or file

In Media Composer, you can output any SD or HD formats as required.

In Avid DS, for a film out, you can output the final sequence to master as a series of DPX or Cineon™ images (with an appropriate LUT) for recording to film.

Opening a Project in MetaFuze

When you start the MetaFuze application, it automatically opens a new empty project. A project in MetaFuze organizes and displays all the elements that are related to the project such as, source file folders, the groups of files created from scanned folders, and the information required to create MXF media files.

If you are starting a new project, you can proceed to “Scanning your Folders” on page 13.

To open an existing project:

1. Select File > Open Project.
2. Select the name of the project (.xml) that you want to open.

The selected project opens and displays the project components.
Customizing the MetaFuze Window

The views and toolbars within MetaFuze can be moved to a different position within the window, or can be “torn off” and dragged outside of the main window.

In addition, the columns in the Groups view can be rearranged or removed as necessary.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 View</td>
<td>Click and drag a view by its title bar. The other views will rearrange to accommodate the new position for this view.</td>
</tr>
<tr>
<td>2 Toolbar</td>
<td>Click the double lines on a toolbar to drag it to a new position. The other views will rearrange to accommodate the new position for the toolbar.</td>
</tr>
<tr>
<td>3 Presets for Group view</td>
<td>You can customize the group view according to the information that you want to display in the columns. Add or remove columns as necessary and save the choices by clicking the Save Preset button. The new preset view will display in the Column Preset list.</td>
</tr>
</tbody>
</table>
To move a view within the main window:

1. Select a view or toolbar that you want to move.
   
   To select a view, click its title bar. To select a toolbar, click the extreme left where you 
   see the vertical dotted line.

2. Drag the view to any position within the window where you would like to place it.
   
   The cursor position determines the destination. If another view exists in that location, it 
   will automatically move over. Release your mouse to drop the selection into place.

Some views can be undocked from the main window by clicking and dragging their title bar 
outside the main window. Doing this creates a new window that you can stretch out if you 
need to see the values more clearly. It also gives you more viewing space for the other views 
in the main window.

The changes that you make to the window display are automatically saved and reloaded 
each time you open MetaFuze.

To change column headings in the Group view:

- Select a column heading and drag it left or right to a new position. Release your mouse 
  button to drop the selected column into place.

  or

- On the toolbar, click the Add/Remove Columns button.

  Use the Ctrl-click or Shift-click to select/deselect any columns that you want to display, 
  and click OK.

  Any changes that you make to the column display can be saved by clicking the Save 
  Preset button. You can save your settings under a new preset file name or modify an 
  existing one.

Scanning your Folders

MetaFuze is designed to scan specified folders and create groups of files based on similar 
file types found in these folders. The scan process groups together any files that have 
consecutive filenames, key numbers, or timecodes. The image resolution (same width and 
height), is also taken into account.

Once the groups have been formed, they can be selected for transcoding.

To scan your folders:

1. Select Actions > Scan Folders.

2. Browse to the folder where your files are located.
1 Using Avid MetaFuze

The folders can be on your local workstation or on remote storage. (To locate folders on a remote storage, you might need to use the full pathname, for example, \\<machine_name>\<folder_name>.)

3. In the list of available folders, select a folder name, and click the Add Folder button to add the folder to the Selected paths list.

4. Select and add as many folders as you want.

5. Option. You can reorder the selected paths using the Up and Down Arrow keys.

6. Option. To remove a folder from the list of selected paths, select the path and click the X button.

7. Click the Options button, and specify the criteria by which you want to group your scanned files — see “Scan Folders Dialog Box” on page 33.

8. By default, the Filename is always considered as one of the criteria. Select the Timecode and/or Key number options if you’d like to use this data as well.

9. You can change the priority order of the criteria by clicking the Up or Down Arrow keys.

10. If you want to specify the type of files to search for, then click the File Types button. Select only the file types that you need. This filters out any unwanted file types and makes the scanning process much faster.

11. Select the other options as necessary.
12. Click the Scan button to begin scanning your files.
   MetaFuze scans the list of selected paths and forms groups based on the options you have selected.
   Once the scan is complete, the main screen displays the list of groups that have been found in the selected paths. After groups have been found, you can proceed to transcode your files.

   *If you have selected the Show scanned information option, the Scan Details dialog box opens when all folders have been scanned.*

13. To save the scanned group information, select File > Save project.
   Enter a project name that will be easily recognized when you export your MXF data for use in other applications.
   MetaFuze saves all the scanned group information to an .xml file.

### Transcoding your Files

MetaFuze converts groups of scanned files into playable Avid MXF or Avid DS .GEN media. In the case of MXF, you can create several MXF files and export an ALE of these files so that you can easily import them in one step from Media Composer.

You can also create an ALE for each format in the selected transcodes with just one press of the 'Export ALE' button. The ALEs will all have the same name but will be appended with a suffix relative to the formats.

*ALE support is not presently available in Avid DS, so you will need to link to each file manually.*

As MetaFuze transcodes the files, it also embeds the required metadata for tape source, timecode, and key number, so that you can later relink to the original source media for finishing on an editing system such as Avid DS.

Metadata can also be added to MXF/GEN files that do not originally contain this information (for example, TIF files). Some of this metadata can be applied as an overlay on the image, much in the same way a telecine transfer would provide window burn-ins of the timecode and key number. Finally, when transcoding, you can also specify a format and a codec to be used to generate the media.
Using Avid MetaFuze

Element Description

1 Source viewer Displays the source image.
2 Output viewer Displays the image according to the selected output settings.
3 Splitbar Click the splitbar and drag it right or left to enlarge/shrink viewer sizes. To reset size, right-click on any viewer and select Auto-adjust.
4 Output Preset dialog Displays the output settings for the selected group.
5 Group view Displays all the scanned and/or transcoded files.
6 Detail view Displays the properties of the object selected in the Group view.
7 Scanned group Click the + button on any group name to expand the tree and list the individual files within the group.

An XML command script can also be used in the Avid MetaFuze console mode to automatically create a list of files for transcoding. For more information, see “Transcoding your Files in a Batch” on page 27.
Transcoding your Files

If you have scanned your files, the Group view at the bottom of the main window displays all groups that have been found. The Group view shows data columns for all possible objects—a group, single-frame file, or transcode job. However, when you select an object, the Detail view on the right will display only the fields that are pertinent to the selected object. You can customize the group view by adding or removing columns—see “Customizing the MetaFuze Window” on page 12.

To transcode a group:

1. In the Group view, select a group.
2. Preview the sequence of files in the group using the play controls just below the viewers.
   The Source viewer displays the original images.
3. In the Output Preset view, you can experiment with the Format and Conversion Mode options to set the best image format and aspect ratio for your output MXF—see “Output Preset View” on page 43 for definitions of the different settings.
   To change any of the output options, click the Create button. This makes a copy of the preset that you can customize. Click in the Name field and enter a new name for your preset.
   The Output viewer shows you how the image will appear based on the transcoding settings in the Details view.
4. If you need to select a LUT for your files, click the LUT field in the Detail view.
   MetaFuze provides a choice of common industry LUTs that you can use. You also have the option to import a LUT that was provided with your footage—see “Importing a LUT” on page 24.

R3D files have the LUT information encoded in the files themselves. MetaFuze also automatically reads any associated RSX/RMD file settings associated to the R3D files. In addition to this, you can also import an RLX/RSX/RMD file which may contain other image settings for the files—see “Importing Image Settings” on page 26.

5. You can also select information to burn-in on the frames—see “Burning-in Information on the Frames” on page 21.
6. If you have media that is to be used for stereoscopic display, you will need to scan your left and right image file groups separately—see “Transcoding Files for Stereoscopic Editing” on page 20.
7. When you are ready to convert a group into a single media file, click the New Transcode button, or use one of the keyboard shortcuts described below.
   A new job is created for transcoding based on the settings in the parent scanned group.
1 Using Avid MetaFuze

There are some fields that are critical to your overall conform workflow, such as key number, tape name, TC start, film type. If you change the settings of these fields in the transcode job, an icon will appear next to them to warn that they are different from the properties of the original scanned group.

The following shortcut keys are available when selecting groups and creating transcode jobs:

<table>
<thead>
<tr>
<th>Option</th>
<th>Keyboard shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>To select or deselect more than one group</td>
<td>Ctrl-click</td>
</tr>
<tr>
<td>To select all groups</td>
<td>Ctrl-A</td>
</tr>
<tr>
<td>To create new transcode jobs for the entire selection</td>
<td>Ctrl-T</td>
</tr>
</tbody>
</table>

You can also create a new transcode job from another transcode job. Simply select the transcode job, change any detail settings, and then click the New Transcode button. The new job will inherit the settings from the original transcode job.

8. Select this new transcode job and set the necessary transcode preferences—see “Detail View” on page 38.

9. If you are working with R3D files, you have the option to change the format of the tapename for RED files that will allow for easier relinking to the source media in applications outside of MetaFuze.

You can also determine which RED color science gets applied to your files during the transcode—see “Setting RED Transcode Options” on page 47.

10. In the Detail view, click on the Folder option, and specify a location where the transcoded media is to be saved.

   If you will be using this media on an Avid Media Composer workstation, you can save the media directly to a shared media folder. Select the appropriate drive, and make sure that you save the media in a path name \Avid Media Files\MXF\1. This is the specific path required by Avid Media Composer when you are importing MXF media.

   If you will be using this media on an Avid DS workstation, you can save it to the shared \Videostorage or \Mediastorage folder on the appropriate workstation. You can then link to this file to create a master clip in Avid DS.

11. In the Output Preset view, set the format options for the transcoded file—see “Output Preset View” on page 43.

12. Click the Transcode button to begin the transcoding, or use one of the keyboard shortcuts described below.
The following shortcut keys are available when selecting transcode jobs and generating transcoded media:

<table>
<thead>
<tr>
<th>Option</th>
<th>Keyboard shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>To select all transcode jobs</td>
<td>Ctrl-Shift-A</td>
</tr>
<tr>
<td>To select and generate media for all remaining transcode jobs.</td>
<td>Ctrl-Shift-T</td>
</tr>
<tr>
<td>To select and regenerate all completed transcode jobs where an MXF/GEN was already previously generated.</td>
<td>Ctrl-Alt-A</td>
</tr>
</tbody>
</table>

Depending on the number of frames in the group, this process could take some time to complete. The status bar displays a message while the transcoding process is in progress.

When you start the transcode process, Metafuze checks for existing MXF/GEN files with the same name, and prompts you with the following choices:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overwrite</td>
<td>If a file with the same name exists, it overwrites the specific file.</td>
</tr>
<tr>
<td>Overwrite All</td>
<td>Overwrites all files with the same name without prompting you each time that it encounters a matching file name.</td>
</tr>
<tr>
<td>Auto-rename</td>
<td>If a file with the same name exists, appends an incremented number to the end of the file name. e.g. Transcode_1080p001.mxf.</td>
</tr>
<tr>
<td>Auto-rename All</td>
<td>Appends an incremented number to the end of the file name that already exists, without prompting you each time that it encounters a matching file name.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Cancels the transcode process.</td>
</tr>
</tbody>
</table>

When the transcoding is complete, the media files are available in the output folder that you specified. Once a job is transcoded, you cannot change the settings. To create another media file with different settings, you need to create another transcode job.

**Changing a Setting for Multiple Files**

You can change the transcode settings for more than one file at a time.
1 Using Avid MetaFuze

To change a setting for multiple files:
1. Multi-select the files.
2. In the Details view, change the setting that you want to apply to all the selected files.
3. Press Enter.

Deleting Transcoded Jobs

You can select and delete transcode groups whether they have been transcoded or not.

To delete a transcode group(s):
1. Select the transcode group(s) that you want to delete.
2. Press the Delete key.

Transcoding Files for Stereoscopic Editing

Stereoscopic imaging involves construction of three-dimensional depth information from two images corresponding to pixels in the left and right eye. MetaFuze can transcode files for stereoscopic editorial in Avid Media Composer and Avid DS.

In MetaFuze, you need to scan your left and right image file groups, and select a suitable mode to combine the left and right eye views into a single frame for the transcoding process.

For Avid Media Composer you must use the Over/Under mode with left eye on the top, and right eye on the bottom. MetaFuze can also combine left and right eyes in Side by side, Anaglyph, and Interlaced modes, which are all supported in Avid DS.

To create a stereoscopic group:
1. Scan the appropriate folders as described in “Scanning your Folders” on page 13.
2. In the Groups view, select the folders for the left and right eyes. (The order in which you select your left and right eye groups is important as it determines the order in which the frames will be combined for transcoding. For Avid Media Composer editing, make sure that you select the left eye group first and then the right.)

   MetaFuze uses the audio associated with the left eye when transcoding.

   To create a stereo group, the left and right eye groups must be of the same file format (frame size and resolution) and have the same duration (number of frames).
Transcoding your Files

3. Click the Create Stereo Group button.

A new group is created containing the left and right eye groups.

If you need to change the order of the groups within the stereo group, you can break the group and start again (Actions > Breakup Stereo Group). Breaking a stereo group simply returns the left and right eye groups to the list of standard groups.

You can also use the following keyboard shortcuts to create or break stereo groups:

<table>
<thead>
<tr>
<th>Option</th>
<th>Keyboard shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>To create a transcode group</td>
<td>Ctrl-G</td>
</tr>
<tr>
<td>To break a stereo transcode group</td>
<td>Ctrl-Shift-G</td>
</tr>
</tbody>
</table>

4. Select the stereo group and set the necessary options — see “Details of a stereoscopic group or transcode job...” on page 42.

5. After you have set the necessary options, click the Transcode button to begin the transcoding process.

Burning-in Information on the Frames

Burn-in data is typically used only for the offline stage of a project. It is useful as it provides visual feedback for logging and tracking footage.

In the Group or Detail view, you can select a data field to burn-in on your images. If you want to burn in more than one field, however, you need to use the Burn-in Editor.
Using Avid MetaFuze

To open the burn-in editor:

1. Select the scanned group and click the Burn-in button on the toolbar.

   The Burn-in Editor opens — see “Burn-in Editor Dialog Box” on page 45 for details on the settings in this dialog box.

   ![Burn-in Editor Dialog Box](image)

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Data list</td>
</tr>
<tr>
<td>2</td>
<td>Position</td>
</tr>
<tr>
<td>3</td>
<td>Font</td>
</tr>
<tr>
<td>4</td>
<td>Save button</td>
</tr>
<tr>
<td>5</td>
<td>Delete button</td>
</tr>
</tbody>
</table>

   2. Select a Burn-in Preset from the list.

   3. Select a field from the Data column, and click the right arrow to add it to the display group.

   The field is added to the group and displays in the Output viewer.

   4. Change the positioning of the display options as required.

   Click any of the Group level columns to change the settings.

   5. Continue to add other data fields to the group.

   To add a line break, select the <NEW LINE> field from the Data list.
Configuring the MetaFuze Transcoder

To create a separate group of fields and place it on a different part of the image, select the <NEW GROUP> field.

6. Click the Save button to save your settings, and enter a name for the preset.
7. Click Close to close the burn-in editor.

Configuring the MetaFuze Transcoder

If you have a multiprocessor system, you can increase the number of processing threads that will be used by MetaFuze when transcoding single-frame files such as DPX, JPG or TIF.

You can also change the tapename format for RED files. Once you choose the appropriate option, it will be used for all RED files that are scanned/rescanned—see “Setting RED Transcode Options” on page 47.

To configure the system transcoder:
1. From the main menu, select Options > Transcode Configuration.
2. MetaFuze shows the number of threads available on your system for processing.
3. You can raise the number of threads to the maximum, but keep in mind that the processing speed is also limited by the capacity to read and write to the hard disk.
   You also need to save some threads for other processes/applications running on your system.

   When transcoding stream files such as AVI, MOV or R3D, the threads will be used to their full capacity, therefore you will not be able to use other applications during the transcoding.

Using LUTs in MetaFuze

A Lookup Table (LUT) is a file that contains a conversion table used to map an input color value to an output color value. When transcoding your files into playable MXF media, you need to set the LUT that came with your footage so that the proper color values are retained throughout the online editing process.

The LUT could come from the film house where the files were scanned, or simply be the LUT associated with the type of camera with which the footage was originally shot.

   In addition, you can load a RED look file (RLX, RSX, RMD) and this will overwrite the associated modified parameters with the settings in this file. This file can be imported into MetaFuze before transcoding your files—see “Importing Image Settings” on page 26.
1 Using Avid MetaFuze

If a LUT was provided with the files you are transcoding, then you should import it into MetaFuze before transcoding the group.

Setting a LUT

After a folder has been scanned, you can set the LUT that will be used for transcoding the scanned files.

To set a LUT:

1. Select the group for which you want to set the LUT.

   This field is only available when you are working with a group of DPX or Cineon files.

2. In the Detail View, click LUT and select an appropriate LUT from the drop-down list.

   The LUT is loaded and you can preview the color settings in the viewer.

Importing a LUT

If the files you are using have an accompanying LUT either from the film-scanning facility, the camera, or the director of photography, then you will need to import it.

To import an LUT:

1. Select the group for which you want to import the LUT.

2. Click the Edit LUTs button at the bottom of the main view.

3. Select Template > From File.

4. Click Create.

5. Browse to the folder where the LUT is located, and click Open.

   The LUT is now available as a choice within MetaFuze.

6. Click Close.

Modifying LUTs

You can edit or create LUTs from the industry LUTs that are provided by MetaFuze.

To edit a LUT:

1. Select the group for which you want to modify the LUT.

2. Click the Edit LUTs button at the bottom of the main view.

   This button is only enabled when you are working with a group of DPX or Cineon files.
3. In the LUT Editor, select a Template type.
4. Click Create.
   A new dialog box opens with the settings of the template.

5. Adjust the values as necessary.

   *The Lock option links values to each other. Deselecting this option for an entry lets you set the values independently.*

6. When you are ready to save the settings, click the Rename button.
7. Enter a new LUT Name and click OK.
   The new LUT is added to the list and will be used for the group that you have selected.

   *These values can be associated with any group within the current project.*

8. Click Close.

**Exporting a LUT**

You can save the LUT settings and export them for use with other MetaFuze groups or external applications.

**To export a LUT:**

1. Select the group whose LUT settings you want to export.
2. Click the Edit LUTs button at the bottom of the main view.
3. Select the LUT that you want to export.
1 **Using Avid MetaFuze**

4. Click the Export button.
5. Select the folder where you want to place the file, and click Save.
6. Click Close.

**Importing Image Settings**

When transcoding R3D files, you can apply additional settings to enhance the “look” of your file. This is done via an RLX, RSX, or RMD file which contains settings that are very similar to a LUT.

Note the following:

- If Metafuze locates an RMD or an RSX file of the same name in the same location as the R3D file, it will apply these settings to the image. If you do not want to use the RMD or RSX file, either remove it or change the extension. (Note that this may affect other applications which use the RMD/RSX file as a way to save their settings.)

  - RMD is an updated version of RSX. If both files are found, then the RMD settings override the RSX.

  - If there is no RMD or RSX file, then Metafuze will use the metadata saved with the R3D file.

  - If no metadata is available, then MetaFuze will use the default values supplied by the SDK.

  *If you need to preserve the color science settings applied to the files, see “Setting RED Transcode Options” on page 47.*

- You can additionally load a look file known as an RLX and this will overwrite the associated modified parameters with this look.

- In MetaFuze, you cannot modify some of the RSX attributes (e.g. Gamma).

**To import an RLX or RMD file:**

1. Select the transcode group to which you want to apply the settings.
2. In the Detail View, click Import Settings and browse to the folder where your RLX file is located.
3. Select the file and click Open.

   The RLX file is loaded and you can preview the color settings in the viewer.
Transcoding your Files in a Batch

You can automate the transcoding process by creating a batch file that lists all the groups to be transcoded.

Before you create the batch file, you need to have already scanned your folders and created the necessary transcoding jobs. An XML script file also needs to be created for each transcoding job. This file holds all the detailed settings for the transcoding job.

All XML scripts can then be executed from one batch file.

To create the XML script file:

1. In the Group view, select the transcoding jobs that you want to convert.
   Alternatively, press Ctrl+Shift+A to select all the transcoding jobs in your project.
2. In the Detail view on the right side of the screen, set the necessary transcoding options — see “Create XML Batch Dialog Box” on page 45.
3. Click the Create XML Batch button.
   The Create XML Batch dialog box opens.

4. In the Script Name textbox, type the name of the XML batch file that you want to create.
   You will be prompted to enter a name for each transcoding job.
5. In the Script Output Folder textbox, type the path where the XML files will be created.
6. Click OK.
   The .xml files will be created using a list of all the files in each transcoding job that you have selected. The XML file contains the same settings found in the Detail view of MetaFuze.

An .XSD reference file is also created, which is useful when using a third-party XML validation tool. The XSD file is used to validate the syntax of your batch file.

7. Once you have created your XML file using MetaFuze, you can edit the script using a text editor and change your <filelist> as necessary.
1 Using Avid MetaFuze

To create a batch file to run all the XML scripts:
1. Create a batch file (.bat) that includes all the XML scripts that you have generated.
   For example:
   ```
   cd C:\Program Files\Avid\MetaFuze
   Metafuze “C:\Documents and Settings\user\Desktop\filename.xml”
   Metafuze “C:\Documents and Settings\user\Desktop\filename2.xml”
   ```
2. Save the batch file.
3. To execute the batch file, simply double-click on it.
   When you execute the batch file, each transcode group’s XML file will first be validated against the XSD to check for the syntax and format. If there are no errors, the transcoded output file is generated based on the job settings in the XML file.

If you only have one XML to transcode, you can simply select the transcode group’s XML file and drag and drop it over the Avid MetaFuze Console icon. This will automatically run the XML script and place the transcoded file in the folder that you specified for the output.

To create an XML file with a third-party application:
1. Generate the .xml and .xsd with MetaFuze.
2. Open the .xml file with Liquid XML Studio from Liquid Technologies (you can download the freeware from http://www.liquid-technologies.com/).
3. Edit your file with Liquid Studio.
4. Use the Validate function in Liquid Studio to validate your .xml file against the .xsd.
5. Option. Open the .xsd with Liquid Studio to find the correct enumeration values.
   Once you have a valid .xml file, it can be interpreted by MetaFuze.

Exporting an ALE from MetaFuze

If you have created multiple MXF files that you want to edit on your Avid Media Composer, you can export an edit list of all these clips via an ALE file.

ALE’s generated by MetaFuze are not currently supported in Avid DS.

If the selected transcodes have different frame rates, then an ALE is generated for each different format that is detected. These ALEs will all have the same name but will be appended with a suffix relative to the formats.
When the ALE file is generated, it will also include source information that was found in the files, such as the timecode, keycode, frame rate, and tape name. However, no sequences or effects are exported.

**To export an ALE:**

1. Use Ctrl-click to select all the transcoded files that you want to include in your ALE.
2. Click the Export ALE button.
3. Save the file(s) in an appropriate location.

A confirmation message box displays when one or more files will overwrite an already existing one. You may choose to:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overwrite</td>
<td>If a file with the same name exists, it overwrites the specific file.</td>
</tr>
<tr>
<td>Overwrite All</td>
<td>Overwrites all files with the same name without prompting you each time that it encounters a matching file name.</td>
</tr>
<tr>
<td>Auto-rename</td>
<td>If a file with the same name exists, appends an incremented number to the end of the file name. e.g. ALE001.</td>
</tr>
<tr>
<td>Auto-rename All</td>
<td>Appends an incremented number to the end of the file name that already exists, without prompting you each time that it encounters a matching file name.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Cancels the export ALE operation.</td>
</tr>
</tbody>
</table>

**Importing MXF Files into Avid Media Composer**

To import MXF files into Avid Media Composer, you can import the ALE created by MetaFuze and link to the associated MXF files. On the other hand, you can simply open a bin via the Media Tool and select the MXF files one at a time. Either way, you need to make sure that all your transcoded MXF files are located in the Avid MediaFiles folder as required by Avid Media Composer (drive letter:\Avid MediaFiles\MXF\1).

**Importing MXF Files via an ALE**

When you import the ALE into Avid Media Composer, it displays a log of all the master clips for which you can import MXF media. You will then need to set certain options to link to the master clips.
Using Avid MetaFuze

To import an ALE file using bins:

1. In Avid Media Composer, right-click the bin, and select Import.
2. Browse to the folder where the ALE file is located, select the file, and click Open.
   The bin displays all master clips that have been imported.
3. In the bin, right-click the master clip(s), and select Relink.
4. In the Relink dialog box, deselected the following:
   - Relink only to media from the current project
   - Match case when comparing tape names.
5. Continue setting the options and click OK.
   The MXF files are relinked to the associated master clips.
6. Proceed to edit.

Importing MXF Files

The Media tool displays all captured video and audio data files stored on the media drives. It also displays media that is stored on local drives directly connected to the Avid editing system and on unmanaged shared storage. You can use it to import the MXF files that were transcoded in MetaFuze.

To import an MXF file using the Media Tool:

1. In Avid Media Composer, select Tools > Media Tool.
2. In the Media Tool Display window, select the Media Drive where the Avid MediaFiles folder is located.
   For example, Video U320 (G:).
   The list of Projects will include the name of the MetaFuze project in which you transcoded your files. (Avid Media Composer finds this name in the metadata of the MXF file).
3. Select the name of the MetaFuze project associated with the transcoded MXF files that you want to import.
4. Make sure that only Master Clips is selected and click OK.
   Master clips are created in the Media Tool window for any MXF files associated with that project.

5. Drag the clip(s) to a bin and proceed with your editing.

### Linking to MXF or GEN Files in Avid DS

To link to MXF files in Avid DS, you can simply open a project and link to the MXF files. You need to make sure that all your transcoded MXF files are located in the \VideoStorage or \MediaStorage folder as required by Avid DS. Refer to the topic on “Creating Linked Clips” in the Avid DS Help.

*Avid DS does not currently support the import of an ALE from MetaFuze, so you will need to link to the MXF/GEN files manually.*
1 Using Avid MetaFuze
Scan Folders Dialog Box

The following table describes the options available in the Scan Folders dialog box.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available folders</td>
<td>Lets you browse to the folder where your source files are located. The folders can be on your local workstation or on a remote storage. (For remote storage, you might need to use the full pathname, e.g. <code>${machine_name}/${folder_name}</code>). Press the Enter key after typing in the path name.</td>
</tr>
<tr>
<td>Selected paths</td>
<td>Shows the folders that will be scanned. You can change the order of these folders using the Up and Down arrow buttons. You can also remove a folder from the list using the X button. The “eye” icon lets you show all subfolder for any selected path. Simply select a path in the list, and then click this button to refocus your Available folders view to this path.</td>
</tr>
<tr>
<td>Options</td>
<td>Click this button to show or hide the Options area.</td>
</tr>
<tr>
<td>Grouping</td>
<td>Determines the criteria to be used when grouping the files. Use the up or down arrow buttons to set the order of the criteria.</td>
</tr>
<tr>
<td>Key Number</td>
<td>Use the key number as the grouping criteria.</td>
</tr>
<tr>
<td>Timecode</td>
<td>Use the timecode as the grouping criteria.</td>
</tr>
<tr>
<td>Filename</td>
<td>Use the filename. This option is always used.</td>
</tr>
</tbody>
</table>
No merge

Searches for file patterns for each item in the selected paths list, as well as their subfolder levels. Unique groupings are formed for each level.

Based on the paths circled in the above example, 15 searches are done.

Merge across subfolders

For each item in the selected paths list, searches for file patterns down through all the subfolders. Unique groupings are formed for each selected path in your list.

Based on the paths circled in the above example, 2 searches are done.
Group View

The Group view shows data columns for all possible objects—a group, single-frame file, or transcode job. When you select an object, only the fields that are pertinent to the selected object will display under the appropriate columns (and in the Detail view on the right).

The following table describes the information columns available in the Group view.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Merge all</td>
<td>Searches for file patterns and forms groupings across all folders in your list of selected paths.</td>
</tr>
<tr>
<td>Include subfolders</td>
<td>Scans all subfolders in the list of selected paths as shown in the preceding examples. If this option is not selected, only the files at the top level of the selected paths are scanned and grouped.</td>
</tr>
<tr>
<td>File Types</td>
<td>Opens a dialog box where you can select only the files that you want to scan. This can drastically improve the time it takes to scan your folders.</td>
</tr>
<tr>
<td>Show scanned information</td>
<td>Displays file details on all groups found, including any duplicate files. This option is useful for analyzing the scan results of a given group.</td>
</tr>
<tr>
<td>Scan</td>
<td>Begin the scanning process.</td>
</tr>
</tbody>
</table>

For all the preceding merge options, duplicate files are discarded in each grouping and only the most recent is kept.
A single asterisk beside a value indicates that a pattern has been found against this criteria item. However, since it was not the top item of priority in your grouping options, the files might not actually be contiguous for this criteria.

A double asterisk beside a tape name indicates that the information has been generated by MetaFuze based on your entry.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the group.</td>
</tr>
<tr>
<td>Folder</td>
<td>Name of folder where this group was found.</td>
</tr>
<tr>
<td>Clip Name</td>
<td>Indicates the name of the MXF/GEN file that will be generated. By default, the name will be taken from the first file in the group, but you can enter a name (using the Detail view) that is more relevant. <strong>If you will be using Avid Media Composer for offlineing, you MUST enter a unique name for the clip.</strong></td>
</tr>
<tr>
<td>Project</td>
<td>Indicates the name of the MetaFuze project. You should enter a name that is meaningful, or corresponds to the name of your project on the Avid editing system.</td>
</tr>
<tr>
<td>Stereoscopic Mode</td>
<td>Indicates a mode used to combine left and right eye views.</td>
</tr>
<tr>
<td>Set Film Info</td>
<td>For a standard transcode, indicates if the film information metadata should be embedded in the MXF.</td>
</tr>
<tr>
<td>Transcode Audio</td>
<td>Select the checkbox to generate MXF files containing the audio portion of the input files. <strong>One MXF is generated per audio channel. If you have multichannel audio, then you will get as many audio MXF files as you have channels.</strong> <strong>Stereoscopic groups use the audio associated with the left eye during transcoding.</strong></td>
</tr>
<tr>
<td>Wav file</td>
<td>Select the checkbox if you want to generate a WAV file containing the audio portion of the input files. The .wav files will be saved in a WAV subfolder under the same folder where the MXF/GEN files are output.</td>
</tr>
<tr>
<td>Column</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Film Type</td>
<td>Displays the film type found in the source media. If this metadata is not found, then the default is set to 35 mm 4 perfs.</td>
</tr>
<tr>
<td>KN Start</td>
<td>The key number found in the first file of the group. If key number metadata was found in the source file, then this field cannot be changed. If the key number was not found in the source file, you will be able to enter a key number if necessary.</td>
</tr>
<tr>
<td>Set Tape Info</td>
<td>This option is always selected. Tape information metadata is automatically embedded in the MXF/GEN.</td>
</tr>
<tr>
<td>Tape Name</td>
<td>The source tape name. For some file types, this name can be changed if necessary. Be careful when changing the name as doing so will not allow you to relink to the source media during the finishing process.</td>
</tr>
<tr>
<td>TC Start</td>
<td>The timecode found in the first file of the group. If timecode metadata was found in the source file, then this field cannot be changed. If the timecode was not found in the source file, you will be able to enter timecode if necessary.</td>
</tr>
<tr>
<td>TC End</td>
<td>Displays the timecode found in the last file of the group.</td>
</tr>
<tr>
<td>Burn-in</td>
<td>Lets you select metadata for burn-in. If you want to burn-in more than one field, see “Burning-in Information on the Frames” on page 21.</td>
</tr>
<tr>
<td>Output Preset</td>
<td>Lets you select an output preset that matches the video format, compression, conversion mode and output file type format that you require for the transcode—see “Output Preset View” on page 43.</td>
</tr>
<tr>
<td>LUT</td>
<td>Enter the type of Lookup Table to be associated with these files. (Only available for DPX and Cineon file types.)</td>
</tr>
<tr>
<td>Nb of frames</td>
<td>Indicates the number of sequential frames found.</td>
</tr>
<tr>
<td>Frame Info</td>
<td>Shows the key number.</td>
</tr>
<tr>
<td>Nb of Duplicates</td>
<td>Indicates the number of duplicate frames found.</td>
</tr>
<tr>
<td>Status</td>
<td>Indicates if this job has been transcoded or not.</td>
</tr>
<tr>
<td>Eye</td>
<td>Enter the appropriate text to indicate the left or right eye frames. This may be useful as burn-in data to provide visual cues on the footage.</td>
</tr>
<tr>
<td>Scene</td>
<td>Enter the name for the scene. This may be useful for burn-in.</td>
</tr>
<tr>
<td>Comment</td>
<td>Enter any comments about the scene or footage. This may be useful for burn-in.</td>
</tr>
</tbody>
</table>
2 Avid MetaFuze Reference

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chroma</td>
<td>Select the level to filter the noise of the chroma component.</td>
</tr>
<tr>
<td>Debayer</td>
<td>Select the amount of detail correction in the debayering process.</td>
</tr>
<tr>
<td>OLPF</td>
<td>Select the OLPF (Optical Low Pass Filtering) level.</td>
</tr>
<tr>
<td></td>
<td>This value can be set before capturing or linking.</td>
</tr>
<tr>
<td>ISO</td>
<td>Set the sensitivity of film light. The lower the number the lower the</td>
</tr>
<tr>
<td></td>
<td>sensitivity of the film.</td>
</tr>
<tr>
<td>Resolution</td>
<td>The resolution quality of the image being extracted by the RED parser.</td>
</tr>
<tr>
<td></td>
<td>The higher the resolution, the slower the encoding process.</td>
</tr>
<tr>
<td>Import Settings</td>
<td>You may use Avid DS or a third-party tool to simulate the “look” of your</td>
</tr>
<tr>
<td></td>
<td>images. These settings (such as black levels, brightness, etc.), can be</td>
</tr>
<tr>
<td></td>
<td>saved to a file, and applied within MetaFuze to the entire group of images</td>
</tr>
<tr>
<td></td>
<td>when generating the MXF/GEN file. Such an example is the .RLX or .RMD file</td>
</tr>
<tr>
<td></td>
<td>which contains metadata for R3D files.</td>
</tr>
<tr>
<td></td>
<td>Simply specify the name and location of this file here.</td>
</tr>
</tbody>
</table>

**Detail View**

This view is available after your folders have been scanned and groups have been created based on patterns found in your files. You can select any group, file, or transcode job in the Group view, and the corresponding object details will be shown in the Detail view.

*The detail view can be undocked from the main view by clicking the maximize view button in the top right corner. Doing this lets you stretch out the box if you need to see the values more clearly. It also gives you more viewing space for the other window displays.*

The details of transcode jobs are based on settings in the scanned parent group. You can change these settings depending on the output format required for the transcoded file. There are some fields that are critical to your overall digital intermediate workflow, such as key number, tape name, TC start, film type. If you change the settings of these fields in the transcode job, an icon will appear next to them to warn that they are different from the properties of the original scanned group.

Refer to the following topics for details on the object you have selected:

- “Details of a group...” on page 39
- “Details of a file...” on page 40
- “Details of a transcode job...” on page 40
## Details of a group...

- “Details of a stereoscopic group or transcode job...” on page 42
- “Details of R3D groups or transcode jobs...” on page 42

### Field Name | Description
---|---
Name | Name of the group.
Folder | Name of the source folder where this group was found.
Film Type | Displays the film type found in the source media. If this metadata is not found, then the default is set to 35 mm 4 perfs.
KN Start | The key number found in the first file of the group. If key number metadata was found in the source file, then this field cannot be changed. If the key number was not found in the source file, you will be able to enter a key number if necessary.
Tape Name | The source tape name. For some file types, this name can be changed if necessary. Be careful when changing the name as doing so will not allow you to relink to the source media during the finishing process.
TC Start | The timecode found in the first file of the group. If timecode metadata was found in the source file, then this field cannot be changed. If the timecode was not found in the source file, you will be able to enter timecode if necessary.
TC End | The timecode found in the last file of the group.
Burn-in | Lets you select metadata for burn-in. If you want to burn-in more than one field, see “Burning-in Information on the Frames” on page 21.
Output Preset | Indicates the output preset to be used. The Output Preset is a separate dialog box containing the format, compression, conversion mode and other output values. See “Output Preset View” on page 43.
LUT | The type of Lookup Table associated with these files. Only available for DPX file types.
Nb of Frames | Number of sequential frames found.
Eye | Enter the appropriate text to indicate the left or right eye frames. This may be useful as burn-in data to provide visual cues on the footage.
Scene | Enter the name for the scene. This may be useful for burn-in.
Details of a file...

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays the name of the selected file.</td>
</tr>
<tr>
<td>Folder</td>
<td>Displays the name of the source folder where this file was found.</td>
</tr>
<tr>
<td>Frame Info</td>
<td>Displays the key number (if applicable), or the frame number.</td>
</tr>
</tbody>
</table>

Details of a transcode job...

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Displays the name given to the transcode job.</td>
</tr>
<tr>
<td>Folder</td>
<td>Lets you specify the destination folder for the transcoded file. If you will be using this media on an Avid Media Composer workstation, you can save the media directly to a shared media folder. Select the appropriate drive, and make sure that you save the media in a path name \Avid Media Files\MXF\1. This is the specific path required by Avid Media Composer when you are importing MXF media. If you are generating GEN media for use on an Avid DS workstation, you can save the media directly to a shared media folder for that workstation (\VideoStorage or \MediaStorage).</td>
</tr>
<tr>
<td>Clip name</td>
<td>Lets you enter the name of the MXF/GEN file that will be created from this transcode job.</td>
</tr>
<tr>
<td>Project</td>
<td>Lets you enter a name for this project. This name should be meaningful or correspond to the name of your project in your Avid editing application.</td>
</tr>
<tr>
<td>Set Film Info</td>
<td>Select the checkbox to include film information metadata in the transcoded file.</td>
</tr>
</tbody>
</table>
Details of a transcoding job...

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transcode Audio</td>
<td>Select the checkbox to generate MXF/GEN files containing the audio portion of the input files. One MXF is generated per audio channel. If you have multichannel audio, then you will get as many audio MXF files as you have channels.</td>
</tr>
<tr>
<td>Wav file</td>
<td>Select the checkbox if you want to generate a WAV file containing the audio portion of the input files. The WAV files will be saved in a WAV subfolder under the same folder where the transcoded files are output.</td>
</tr>
<tr>
<td>Film Type</td>
<td>Displays the film type found in the source media. If this metadata is not found, then the default is set to 35 mm 4 perfs.</td>
</tr>
<tr>
<td>KN Start</td>
<td>The key number found in the first file of the group. If key number metadata was found in the source file, then this field cannot be changed. If the key number was not found in the source file, you will be able to enter a key number if necessary.</td>
</tr>
<tr>
<td>Set Tape Info</td>
<td>This option is always selected. Tape information metadata is automatically embedded in the MXF/GEN file.</td>
</tr>
<tr>
<td>Tape Name</td>
<td>The source tape name. For some file types, this name can be changed if necessary.</td>
</tr>
<tr>
<td>TC Start</td>
<td>The timecode found in the first file of the group. The start timecode can be changed if necessary, and the end timecode will automatically be adjusted.</td>
</tr>
<tr>
<td>TC End</td>
<td>The timecode found in the last file of the group.</td>
</tr>
<tr>
<td>Burn-in</td>
<td>Lets you select metadata for burn-in. If you want to burn-in more than one field, see “Burning-in Information on the Frames” on page 21.</td>
</tr>
<tr>
<td>Output Preset</td>
<td>Indicates the output preset to be used. The Output Preset is a separate dialog box containing the format, compression, conversion mode and other output values. See “Output Preset View” on page 43.</td>
</tr>
<tr>
<td>LUT</td>
<td>Enter the type of Lookup Table to be associated with these files. (Only available for DPX file types.)</td>
</tr>
<tr>
<td>Status</td>
<td>Indicates if the job has been transcoded or not.</td>
</tr>
<tr>
<td>Eye</td>
<td>Enter the appropriate text to indicate the left or right eye frames. This may be useful as burn-in data to provide visual cues on the footage.</td>
</tr>
<tr>
<td>Scene</td>
<td>Enter the name for the scene. This may be useful for burn-in.</td>
</tr>
</tbody>
</table>
Details of a stereoscopic group or transcode job...

The following additional options are available when you select groups or transcode jobs that have stereoscopic files—see “Transcoding Files for Stereoscopic Editing” on page 20.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comment</td>
<td>Enter any comments about the scene or footage. This may be useful for burn-in.</td>
</tr>
<tr>
<td>Stereoscopic Mode</td>
<td>Select a mode to combine the left and right eye views into a single frame for the transcoding process.</td>
</tr>
<tr>
<td>Interlaced</td>
<td>Interleaves every alternate line from the left and right eye images into a single frame.</td>
</tr>
<tr>
<td>Over/Under</td>
<td>Places the left and right eye images one above the other in a horizontal split frame.</td>
</tr>
<tr>
<td>Side by Side</td>
<td>Places the left and right eye images side by side in a vertical split frame.</td>
</tr>
<tr>
<td>Anaglyphic</td>
<td>Each left and right eye image is made up of two color layers which are superimposed to create a stereoscopic depth effect that can be viewed with two-color 3D glasses.</td>
</tr>
<tr>
<td>Transcode Audio</td>
<td>Select the checkbox to generate MXF/GEN files containing the audio portion of the input files.</td>
</tr>
</tbody>
</table>

- One MXF is generated per audio channel. If you have multichannel audio, then you will get as many audio MXF files as you have channels.
- Stereoscopic groups use the audio associated with the left eye during transcoding.

Details of R3D groups or transcode jobs...

The following additional options are available when you select groups or transcode jobs that have R3D files.
The video format, compression, conversion mode and output file type formats are grouped as an Output Preset. There is a default output preset for each video format. The default output preset associated with a scanned group will have the same framerate, resolution and bit depth if those values are supported.

Each of these presets can be customized and shared between MetaFuze workstations.

### Field Name | Description
--- | ---
Chroma | Select the level to filter the noise of the chroma component.
Debayer | Select the amount of detail correction in the debayering process.
OLPF | Select the OLPF (Optical Low Pass Filtering) level.
ISO | Set the sensitivity of film light. The lower the number the lower the sensitivity of the film.
Black Level | Adjust the black level.
Resolution | The resolution quality of the image being extracted by the RED parser.
| The higher the resolution, the slower the encoding process.
Import Settings | Load an existing RLX or RMD file. Use the browse button to find and load the file.

## Output Preset View

The video format, compression, conversion mode and output file type formats are grouped as an Output Preset. There is a default output preset for each video format. The default output preset associated with a scanned group will have the same framerate, resolution and bit depth if those values are supported.

Each of these presets can be customized and shared between MetaFuze workstations.

### Field Name | Description
--- | ---
Output Preset | The name of the preset.
Create | Click this button to create a copy of the selected preset that you can customize.
| The fields in this dialog can then be modified. You should also enter a new name for the output preset.
Export | Export this preset for use on another MetaFuze workstation. The file is saved in .XML format.
Import | Import an output preset created on another MetaFuze workstation.
Delete Delete a customized preset.

Name If this is a user-created preset, you may enter a new name in this field.

Format Lets you set the format for the output sequence based on supported formats for the scanned group. The format automatically determines the frame rate, frame size, field dominance, aspect ratio, and pixel ratio for the media.

Compression Lets you select the appropriate compression ratio to be used during conversion.

Uncompressed No compression.

DNxHD Avid DNxHD is a 8- and 10-bit HD encoding technology that delivers mastering-quality HD media with storage bandwidth and capacity requirements similar to those of uncompressed standard-definition (SD) files. Avid DNxHD operates in a 4:2:2 color space at much lower, more efficient data rates.

The options available here depend on the Format chosen for the MXF output file.

Also, note that 8-bit compression is not available for source media that is 10-bit.

Conversion mode Lets you select the aspect ratio that will be used during conversion. When converting between film/HD and NTSC formats, you must make sure that the aspect ratio is respected. Film/HD uses the aspect ratio of 16:9, while NTSC/PAL uses 4:3.

Choose the mode that will be used for final output.

Anamorphic If your images are 16:9, they are stretched vertically to fit into a 4:3 NTSC frame.

Letterbox Use this option to preserve aspect ratio when going converting from HD to NTSC. If your images are 16:9, they are placed in the center of the 4:3 NTSC frame and black bars are added to the top and/or bottom of the image.

Choose the appropriate letterbox option.

Pillars Select this option is to preserve the aspect ratio when going from NTSC to HD. The 4:3 image is placed in the center of the 16:9 HD frame and black bars are added to the left and right sides of the image.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete</td>
<td>Delete a customized preset.</td>
</tr>
<tr>
<td>Name</td>
<td>If this is a user-created preset, you may enter a new name in this field.</td>
</tr>
<tr>
<td>Format</td>
<td>Lets you set the format for the output sequence based on supported formats for the scanned group. The format automatically determines the frame rate, frame size, field dominance, aspect ratio, and pixel ratio for the media.</td>
</tr>
<tr>
<td>Compression</td>
<td>Lets you select the appropriate compression ratio to be used during conversion.</td>
</tr>
<tr>
<td>Uncompressed</td>
<td>No compression.</td>
</tr>
<tr>
<td>DNxHD</td>
<td>Avid DNxHD is a 8- and 10-bit HD encoding technology that delivers mastering-quality HD media with storage bandwidth and capacity requirements similar to those of uncompressed standard-definition (SD) files. Avid DNxHD operates in a 4:2:2 color space at much lower, more efficient data rates. The options available here depend on the Format chosen for the MXF output file. Also, note that 8-bit compression is not available for source media that is 10-bit.</td>
</tr>
<tr>
<td>Conversion mode</td>
<td>Lets you select the aspect ratio that will be used during conversion. When converting between film/HD and NTSC formats, you must make sure that the aspect ratio is respected. Film/HD uses the aspect ratio of 16:9, while NTSC/PAL uses 4:3. Choose the mode that will be used for final output.</td>
</tr>
<tr>
<td>Anamorphic</td>
<td>If your images are 16:9, they are stretched vertically to fit into a 4:3 NTSC frame.</td>
</tr>
<tr>
<td>Letterbox</td>
<td>Use this option to preserve aspect ratio when going converting from HD to NTSC. If your images are 16:9, they are placed in the center of the 4:3 NTSC frame and black bars are added to the top and/or bottom of the image. Choose the appropriate letterbox option.</td>
</tr>
<tr>
<td>Pillars</td>
<td>Select this option is to preserve the aspect ratio when going from NTSC to HD. The 4:3 image is placed in the center of the 16:9 HD frame and black bars are added to the left and right sides of the image.</td>
</tr>
</tbody>
</table>
Create XML Batch Dialog Box

The following table describes the XML file options available in the Batch Transcode dialog box.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video File Type</td>
<td>Select the media format to which you want to transcode your files. You can choose between MXF and GEN formats. GEN media is the proprietary format for Avid DS.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Script Name</td>
<td>Enter the name for the XML file that is to be created.</td>
</tr>
<tr>
<td>Script Output Folder</td>
<td>Enter the path where the files will be placed.</td>
</tr>
<tr>
<td>XML Schema (*.xsd)</td>
<td>Creates a file, called MetafuzeBatchTranscode.xsd, containing XML-based schema. This file can be used by a third-party tool to validate the format and syntax of your .xml batch files when executing the batch transcode command.</td>
</tr>
</tbody>
</table>

Burn-in Editor Dialog Box

The following table describes the options available in the Burn-in Editor dialog box.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Burn-in Preset</td>
<td>The name of the file where the settings are stored.</td>
</tr>
<tr>
<td>Save button</td>
<td>Click this button to create a new preset, or save changes to a selected preset.</td>
</tr>
<tr>
<td>Delete button</td>
<td>Click this button to delete a selected preset.</td>
</tr>
<tr>
<td>Import</td>
<td>Import a burn-in preset file (.xml).</td>
</tr>
<tr>
<td>Export</td>
<td>Export a burn-in preset file (.xml).</td>
</tr>
<tr>
<td>Data</td>
<td>A list of data fields that can be burned-in on your images. NEW LINE - inserts a line break between data fields. NEW GROUP - creates a new group of data fields.</td>
</tr>
</tbody>
</table>
Transcode Configuration Options

If you have a multiprocessor machine, you can set the number of threads that can be used by MetaFuze.

Increasing the number of processing threads generally provides greater performance, but it may decrease the power of other applications that are running simultaneously.

*When transcoding stream files such as AVI, MOV or R3D, the threads will be used to their full capacity, therefore you will not be able to use other applications during the transcoding.*

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Threads for local files</td>
<td>Set the number of processing threads to be used when reading/writing files locally.</td>
</tr>
<tr>
<td>Threads for remote files</td>
<td>Set the number of processing threads to be used when reading/writing files remotely.</td>
</tr>
</tbody>
</table>
Setting RED Transcode Options

You have the option to change the format of the tapename for RED files that will allow for easier relinking to the source media in applications outside of MetaFuze. Once you choose the appropriate format, it will be used for all RED files that have been scanned/rescanned.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Force Minimum Color Science Version</td>
<td>The color science varies according to the firmware version of the camera that shot the footage. Selecting this option applies the older color science when more than one color version is available amongst the scanned R3D files. Each file is treated independently based on the color science available for the file. If you want to use the latest color science on all your files, do not select this option.</td>
</tr>
<tr>
<td>Default Tape Name</td>
<td>Specify one of the options below for all files to be transcoded with the new tape name.</td>
</tr>
<tr>
<td>FILENAME (default)</td>
<td>Uses the filename as the tapename.</td>
</tr>
<tr>
<td>REEL + CAMERA + DATE</td>
<td>Uses a combination of the reelname, camera, and the date that is in the file metadata.</td>
</tr>
<tr>
<td>REEL</td>
<td>Uses the reel name as the tapename.</td>
</tr>
<tr>
<td>REEL + CAMERA</td>
<td>Uses a combination of the reel name and camera that is in the file metadata.</td>
</tr>
</tbody>
</table>